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Welcome to the Microsoft Windows System Utilities Practice Lab. In this module,
you will be provided with the instructions and devices needed to develop your hands-on
skills.

Learning Outcomes

In this module, you will complete the following exercise:

Exercise 1 - Get to know Various System Utilities

After completing this lab, you will be able to:

Explore Registry Editor
Use the Services Console
Use the Microsoft Terminal Services Client (MSTSC)
Use Notepad



Use File Explorer
Use MSinfo32
Use the Microsoft Management Console (MMC)
Use Dxdiag
Use the Defragment and Optimize Drives Utility
Use Windows Update

Exam Objectives

The following exam objectives are covered in this lab:

220-1002: 1.8 Getting to know Microsoft system utilities

Note: Our main focus is to cover the practical, hands-on aspects of the exam
objectives. We recommend referring to course material or a search engine to
research theoretical topics in more detail.

Lab Duration

It will take approximately 1 hour to complete this lab.

Help and Support

For more information on using Practice Labs, please see our Help and Support page.
You can also raise a technical support ticket from this page.

Click Next to view the Lab topology used in this module.

Lab Topology

During your session, you will have access to the following lab configuration.



Depending on the exercises, you may or may not use all of the devices, but they are
shown here in the layout to get an overall understanding of the topology of the lab.

PLABDC01 - (Windows Server 2016 - Domain Controller)
PLABWIN10 - (Windows 10 - Domain Member)
PLABCENTOS - (CentOS Server)
PLABWIN810 - (Windows 8.1 - Domain Member)
PLABWIN701 - (Windows 7 - Domain Member)

Click Next to proceed to the first exercise.

Exercise 1 - Get to Know Various System Utilities



System utilities are a set of programs that help a user manage and personalize a system
according to his or her needs. A utility program is different from typical application
software. A utility program is generally small and performs a specific task. For example,
Remote Desktop Program (RDP) can be considered a utility program, which is designed
to connect with a remote computer. Similarly, the registry editor is meant to edit the
registry. Each of these work in isolation in most cases. However, some of these utilities
can also be linked a common purpose utility, such as Computer Management.

In this exercise, you will work with RDP and connect computers remotely.

Learning Outcomes

After completing this exercise, you will be able to:

Explore Registry Editor
Use the Services Console
Use the Microsoft Terminal Services Client (MSTSC)
Use Notepad
Use File Explorer
Use MSinfo32
Use the Microsoft Management Console (MMC)
Use Dxdiag
Use the Defragment and Optimize Drives Utility
Use Windows Update

Your Devices

You will be using the following devices in this lab. Please power these on now.

PLABWIN10 - (Windows 10 - Domain Member)
PLABWIN810 - (Windows 8.1 - Domain Member)



Task 1 - Explore Registry Editor

The registry editor allows you to view, update, and search for Windows registry settings.
Windows registry is a database that contains various Windows configuration settings.
Using the Registry Editor, you can modify, add, or delete settings. However, changes to
these settings should be made with caution. A single wrong edit to the registry can stop
the functioning of the computer.

In this task, you will explore Registry Editor.

Step 1
Ensure PLABWIN10 is powered on and connected.

The desktop is displayed.

In the Type here to search textbox in the taskbar and type the following command:

regedit



Click on the regedit result.



Figure 1.1 Screenshot of PLABWIN10: Selecting regedit from the search.

Step 2
The Registry Editor window is displayed. It is important to note that other than the
system configuration settings, Windows Registry also stores information, such as
installed applications, security settings, and drivers information.

Notice that there are various root keys, which are:

HKCR (HKEY_CLASSES_ROOT): Contains the information about various file
types, file extensions, and OLE.
HKCU (HKEY_CURRENT_USER): Contains information about the currently
logged in user and the settings assigned to the user.
HKLM (HKEY_LOCAL_MACHINE): Contains hardware and software settings
that are specific to the system. This is the most used registry key.



HKU (HKEY_USERS): Contains information about the users who have logged on
to the system. Both, generic and user-specific, information is contained in this
registry key.
HKEY_CURRENT_CONFIG (HKCC): Contains the system hardware
information.

Figure 1.2 Screenshot of PLABWIN10: Showing the Registry Editor window.

Step 3
In the left pane, under Computer, select the folder named HKEY_CLASSES_ROOT.

In the right pane, right-click the (Default) key and select Modify.



Figure 1.3 Screenshot of PLABWIN10: Right-clicking the (Default) key and then
selecting the Modify option from the context menu.

Step 4
The Edit String dialog box appears.

By filling in the Value data field, a new value can be assigned to the file.

Note: For this task, you should not make any changes to the registry. Any
unwanted change can cause system issues.

Close the Edit String dialog box. You are now back on the Registry Editor window.



Figure 1.4 Screenshot of PLABWIN10: Showing the Edit String dialog box with
no value mentioned in the Value data textbox.

Step 5
Right-click in the right-hand pane, select New and then select Key.

Adding a new key in the registry is simple as long as you are aware of what needs to be
added. Any unwanted key or a key with the wrong value can cause system issues, such as
a non-bootable system.

Note: For this task, you should not make any changes to the registry. Any
unwanted change can cause system issues.

Close the Edit String dialog box. You are now back on the Registry Editor window.



Figure 1.5 Screenshot of PLABWIN10: Right-clicking in the right pane and
selecting the New ( Key option from the context menu.

Step 6
Notice that a new key has been added to HKEY_CLASSES_ROOT. You can add a key
to any of the root keys.

Notice that in the right pane, no value has been set for the (Default) key.



Figure 1.6 Screenshot of PLABWIN10: Showing a new key added in
HKEY_CLASSES_ROOT.

Step 7
You now know how to add or update a key. Deleting a key is also a simple task. Right-
click New Key #1 in the left pane and select Delete.



Figure 1.7 Screenshot of PLABWIN10: Right-clicking New Key #1 and selecting
Delete to delete the key.

Step 8
In the Confirm Key Delete dialog box, click Yes.



Figure 1.8 Screenshot of PLABWIN10: Confirming the key deletion.

Step 9
Notice that the key no longer exists.



Figure 1.9 Screenshot of PLABWIN10: Showing that the deleted key no longer
exists. Closing the Registry Editor window.

Close the Registry Editor window.

Step 10
You should have now returned to the desktop.



Figure 1.10 Screenshot of PLABWIN10: Showing the desktop of PLABWIN10.

Task 2 - Use the Services Console

Several Windows components are dependent on the services that run in the Services
console. Many of the services start when the system boots up. Other services, which are
created when applications are installed, can either start with the system boot up or can be
manually started. They can also be disabled if a specific Windows component is not
required at the moment.

In this task, you will use the Services console.

Step 1
Ensure that you are connected to PLABWIN10.

In the Type here to search textbox in the taskbar and type the following command:



services.msc



Under the Best Match section, select Services.

Figure 1.11 Screenshot of PLABWIN10: Selecting services.msc from the search.

Step 2
Notice that the Services console is displayed. The services are listed in the alphabetical
order.



Figure 1.12 Screenshot of PLABWIN10: Displaying the Services console with
the services listed in the alphabetical order.

Step 3
Right Click Application Information and click Start



Figure 1.13 Screenshot of PLABWIN10: Right-clicking the Application
Information service and selecting Start from the context menu.

Step 4
You can sort the services according to their status. Click Status.



Figure 1.14 Screenshot of PLABWIN10: Sorting the services according to their
status.

Step 5
Services are now sorted according to their status.



Figure 1.15 Screenshot of PLABWIN10: Showing the sorted services according
to their status.

Step 6
Click Status once again.

Notice that the services with the Running status are now listed. When you scroll down,
you will find the services with no status are listed. No is shown means that the service is
stopped.

Note: You can use any column heading to sort the services.



Figure 1.16 Screenshot of PLABWIN10: Sorting the services once again and
listing the Running services on top.

Step 7
Let’s attempt to stop a service.

Select Application information in the Name column, then right-click and select
Stop.

Doing this will cause the service to stop its ongoing execution.



Figure 1.17 Screenshot of PLABWIN10: Right-clicking the Application
Information service and selecting Stop from the context menu.

Step 8
A dialog box showing the progress to stop the service appears for a moment. As soon as
the service is disabled, the dialog box disappears.

Notice that the service is no longer listed with the Running status.



Figure 1.18 Screenshot of PLABWIN10: Showing only the services with the
Running status.

Step 9
Right-click Application Information and select Properties.



Figure 1.19 Screenshot of PLABWIN10: Right-clicking the Application
Information service and selecting Properties from the context menu.

Step 10
In the Application Information Properties (Local Computer) dialog box, notice
that the Service status is set as Stopped.

Click Start.



Figure 1.20 Screenshot of PLABWIN10: Clicking Start in the Application
Information Properties (Local Computer) dialog box.

Step 11
Notice that the Service status is now set as Running.



Figure 1.21 Screenshot of PLABWIN10: Showing the Application Information
service status as Running.

Step 12
Move the Application Information Properties (Local Computer) dialog box
towards the left to ensure that the Application Information service is visible in the
Services console.



Figure 1.22 Screenshot of PLABWIN10: Showing the Application Information
service with the Running status in the Services console.

Step 13
Let’s change the Startup Type for the Application Information service.

Currently, the service is set to Manual.



Figure 1.23 Screenshot of PLABWIN10: Showing the Startup type as Manual for
the Application Information service.

Step 14
Click the Startup type drop-down and select Automatic.



Figure 1.24 Screenshot of PLABWIN10: Selecting Automatic as the Startup type
for the Application Information service.

Step 15
In the Startup type drop-down, the service is now set to Automatic.



Figure 1.25 Screenshot of PLABWIN10: Showing Automatic as the Startup type
for the Application Information service.

Step 16
Click the Log On tab.

A service can be set to either start with the Local System account or with a specific
account. For this task, keep the default settings.



Figure 1.26 Screenshot of PLABWIN10: Clicking the Log On tab and then
verifying the Log on as status.

Step 17
Click the Recovery tab. This tab allows you to trigger an action if the service fails. By
default, the first, second, and subsequent failures are set to Take No Action.

In this task, you will change this to Restart the Service for the first failure.

From the First failure drop-down, select Restart the Service.



Figure 1.27 Screenshot of PLABWIN10: Clicking the Recovery tab and setting
Restart the Service for the First failure.

Step 18
The First failure drop-down is now set to Restart the Service.



Figure 1.28 Screenshot of PLABWIN10: Showing Restart the Service as the
configured option for the First failure.

Step 19
Click the Dependencies tab. Note that this service depends on two different services. If
both / either of the services fail, this service will not start.

Click OK to close the Application Information Properties (Local Computer)
dialog box.



Figure 1.29 Screenshot of PLABWIN10: Showing the Dependencies tab and
then closing the dialog box.

Step 20
In the left pane, notice the Services (Local) node.

This means that the Services console is displaying the services of the local system.
However, you can also see the services running from another system on the network if
needed.



Figure 1.30 Screenshot of PLABWIN10: Displaying the services of the local
system.

Step 21
Right-click Services (Local) and select Connect to another computer.



Figure 1.31 Screenshot of PLABWIN10: Selecting the Connect to another
computer option from the context menu.

Step 22
Select Another computer if already not selected. In the textbox, type the following
name:

PLABWIN810



Click OK.



Figure 1.32 Screenshot of PLABWIN10: Connecting to PLABWIN810 to display
its services.

Step 23
Notice that the services from PLABWIN810 are now displayed in the Services console.



Figure 1.33 Screenshot of PLABWIN10: Displaying the services of
PLABWIN810.

Close the Services console.

Step 24
You should have now returned to the desktop.



Figure 1.34 Screenshot of PLABWIN10: Showing the desktop of PLABWIN10.

Task 3 - Use the Microsoft Terminal Services Client (MSTSC)

Microsoft Terminal Services Client (MSTSC) is used for connecting to another system
remotely. Using MSTSC, you can connect to another system and work as you are working
on your own system. Windows has in-built support for the Remote Desktop Protocol
(RDP), which is used by Microsoft Terminal Services client. On Linux, you can use an
application named freerdp, which is freely available. It also has the support for RDP.

In this task, you will establish a connection using MSTSC.

Step 1
Ensure that you are connected to PLABWIN10.

In the Type here to search textbox in the taskbar, type the following command:



MSTSC



Under the Best Match section, select Remote Desktop Connection.

Figure 1.35 Screenshot of PLABWIN10: Selecting Remote Desktop Connection
from the search.

Step 2
The Remote Desktop Connection dialog box is displayed.

In the Computer textbox, you need to enter the name of the system you want to connect
remotely.

Type the following name in the Computer textbox:



PLABDC01



Then, click Connect.

Figure 1.36 Screenshot of PLABWIN10: Entering the name of the remote
computer in the Remote Desktop Connection dialog box.

Step 3
The Windows Security dialog box is displayed.

To sign in as PRACTICELABS\Administrator, type the following password:

Passw0rd 




Then, click OK.

Note: If you do not want to connect with the PRACTICELABS\Administrator
account, you can click the More choices link and select Use a different account.

Figure 1.37 Screenshot of PLABWIN10: Entering the password for connecting
to the remote computer.

Step 4
After authentication is successful, you will notice that a dialog box appears for a few
seconds attempting to establish a connection with the remote system, which is
PLABDC01 in this task.



Figure 1.38 Screenshot of PLABWIN10: Showing the Remote Desktop
Connection dialog box with the attempt to connect to the remote computer.

Step 5
After the connection is established, the desktop of the remote system, PLABDC01, is
now visible. Notice that the remote system is now displayed with full screen.



Figure 1.39 Screenshot of PLABWIN10: Showing the desktop of the remote
computer after successful connection.

Step 6
The remote connection bar is displayed on top of the screen. You can make this remote
connection bar disappear by clicking anywhere on the desktop.



Figure 1.40 Screenshot of PLABWIN10: Making the remote connection bar
disappear.

Step 7
To bring the remote connection bar back, move the cursor to the middle of the top of the
screen.



Figure 1.41 Screenshot of PLABWIN10: Displaying the remote connection bar.

Step 8
You can make the remote connection bar visible all the time by clicking the pin, which is
the first icon.



Figure 1.42 Screenshot of PLABWIN10: Pinning the remote connection bar.

Step 9
After pinning it, click anywhere on the desktop. Notice that the remote connection bar
does not disappear this time.



Figure 1.43 Screenshot of PLABWIN10: Showing the remote connection bar.

Step 10
Click the Security info icon.



Figure 1.44 Screenshot of PLABWIN10: Clicking the Security info icon.

Step 11
In the Remote Desktop Connection dialog box, notice that it states that the identity
of the remote computer was verified by Kerberos. Click OK.



Figure 1.45 Screenshot of PLABWIN10: Clicking OK to close the Remote
Desktop Connection dialog box.

Step 12
Click the Connection info icon.



Figure 1.46 Screenshot of PLABWIN10: Clicking the Connection info icon.

Step 13
In the Remote Desktop Connection dialog box, notice that it states that the quality of
the connection to the remote computer is good and has UDP enabled. Click OK.



Figure 1.47 Screenshot of PLABWIN10: Showing the Remote Desktop
Connection dialog box.

Step 14
Click Close.



Figure 1.48 Screenshot of PLABWIN10: Closing the remote session.

Step 15
In the Remote Desktop Connection dialog box, click OK to close the remote session.



Figure 1.49 Screenshot of PLABWIN10: Clicking OK on the Remote Desktop
Connection dialog box to close the remote session.

Step 16
You are now back on the PLABWIN10’s desktop. Invoke the MSTSC client once again.

Notice that PLABDC01 name appears automatically.

Note: You can overwrite this name. Whichever remote system you connect with,
the names are cached.



Figure 1.50 Screenshot of PLABWIN10: Invoking the Remote Desktop
Connection dialog box once again.

Step 17
Click Show Options.



Figure 1.51 Screenshot of PLABWIN10: Clicking Show Options.

Step 18
The Remote Desktop Connection dialog box is displayed. By default, the General
tab is displayed. In the General tab, you can either use the remote system name or IP
address and then provide the username that you want to use.

Previously, you had connected with PLABDC01. Notice that its name and username are
already added. You can choose to connect with a different system and with a different
username.



Figure 1.52 Screenshot of PLABWIN10: Displaying the General tab of the
Remote Desktop Connection dialog box.

Step 19
When you click Save, the existing settings will be saved. Click Save As to save it as a file,
which can be used later.



Figure 1.53 Screenshot of PLABWIN10: Displaying the system name with the
remote system name and user name.

Step 20
The Save As dialog box is displayed. Notice that File name is Default.



Figure 1.54 Screenshot of PLABWIN10: Saving the remote connection
information in the .RDP file.

Step 21
In the File name textbox, type the following name:

PLABDC01



Click Save.



Figure 1.55 Screenshot of PLABWIN10: Saving the .RDP file with the
PLABDC01 name.

Step 22
You are back on the General tab. Click Open.



Figure 1.56 Screenshot of PLABWIN10: Clicking the Open button on the
General tab.

Step 23
The Open dialog box is displayed. Select PLABDC01 if already not selected.

Click Open.



Figure 1.57 Screenshot of PLABWIN10: Opening the saved PLABDC01.RDP
file.

Step 24
Notice that the PLABDC01 settings are loaded. However, the username was not loaded.
If you need the username to be loaded with the settings, you would need to select the
Allow me to save credentials checkbox.



Figure 1.58 Screenshot of PLABWIN10: Loading the remote session details
from the PLABDC01.RDP file.

Step 25
Click the Display tab. Here, you can configure the display settings. If you have a slow
connection, then you can lower the quality from the Highest Quality (32 bit) drop-
down.

Also, by default, remote desktop is displayed to the full screen. You can drag the bar to
the left to decrease the window size.

For this task, you can leave the default settings.



Figure 1.59 Screenshot of PLABWIN10: Showing the settings on the Display
tab.

Step 26
Click the Local Resources tab. There are three key settings that can be done on this
tab:

Remote audio: When the remote system plays audio, this specifies where audio
will be played. By default, it is set to the computer managing the remote connection.
Remote audio recording is not configured by default.
Keyboard: This controls where an action will be performed when you press a
combination of keys, such as Alt+Tab.
Local devices and resources: The system, which you are using for managing the
remote system, can have printers configured. With the default setting, the remote



system can use the printer that is configured on your local system. The clipboard is
also configured in the same manner.

Figure 1.60 Screenshot of PLABWIN10: Showing the settings on the Local
Resources tab.

Step 27
Click the Experience tab. On this tab, you can configure settings, such as connection
type and reconnection if connection breaks.



Figure 1.61 Screenshot of PLABWIN10: Showing the settings on the Experience
tab.

Step 28
Click the Advanced tab. On this tab, you can configure settings, such as server
authentication and Remote Desktop Gateway settings.

Click Close to close the Remote Desktop Connection dialog box.



Figure 1.62 Screenshot of PLABWIN10: Showing the settings on the Advanced
tab.

Step 29
You should have now returned to the desktop.



Figure 1.63 Screenshot of PLABWIN10: Showing the desktop of PLABWIN10.

Task 4 - Use Notepad

Notepad is a system utility which is useful for text editing.

Notepad allows you to apply some basic styling aspects to your text, such as font style and
size. It also provides some other basics formatting features, such as word-wrapping.
Notepad has an inbuilt search facility to search within the written content. The document
can also be saved.

In this task, you will explore Notepad.

Step 1
Go to the search box in the taskbar and type:



Notepad



Select the Notepad result from the search.

Figure 1.64 Screenshot of PLABWIN10: Selecting Notepad from the search

Step 2
The Untitled - Notepad window is displayed.

Note: The Untitled - Notepad name will remain until you save the file with your
chosen file name.



Figure 1.65 Screenshot of PLABWIN10: Showing the Untitled - Notepad
document in the Notepad window.

Step 3
Notice that by default, Notepad does not display the status bar. Let’s enable the status
bar.

Click View and select Status Bar.



Figure 1.66 Screenshot of PLABWIN10: Selecting the Status Bar option from
the View menu.

Step 4
The right side of the status bar shows the cursor location.

It currently states Ln 1, Col 1.



Figure 1.67 Screenshot of PLABWIN10: Showing the cursor location in the
status bar.

Step 5
Press Spacebar once.

Notice that the status bar now states Ln 1, Col 2.



Figure 1.68 Screenshot of PLABWIN10: Showing the updated cursor location in
the status bar.

Step 6
Click File and select New.



Figure 1.69 Screenshot of PLABWIN10: Opening a new file from the File menu.

Step 7
The Notepad dialog box is displayed. Even though you had not typed anything in the
notepad, you had moved the cursor from Ln 1, Col 1 to Ln 1, Col 2. Notepad assumes
that some changes to the new document have been made. It then prompts you to save the
document.

Click Don’t Save.



Figure 1.70 Screenshot of PLABWIN10: Clicking the Don’t Save option in the
Notepad dialog box.

Step 8
Notice that a new Untitled - Notepad document is opened. The status bar again
displays Ln 1, Col 1.



Figure 1.71 Screenshot of PLABWIN10: Showing the new document with the
current cursor status.

Step 9
Let’s now look at the page layout settings.

Click File and select Page Setup.



Figure 1.72 Screenshot of PLABWIN10: Selecting the Page Setup option from
the File menu.

Step 10
The Page Setup dialog box is displayed. You can set the page orientation, choose the
paper size, set the margins, and also header/footer.

Leave the default settings and click Cancel.



Figure 1.73 Screenshot of PLABWIN10: Showing the Page Setup dialog box.

Step 11
Click Edit in the menu bar. There are various commands available. Some of the key
commands are:

Find: You can search a word using this option.
Replace: You can find and replace a word. You can even restrict the replacement of
a word on the basis of the casing. If the case matches, then only the word will be
found and replaced.
Go To: You can go to a specific line by entering its number.
Time/Date: You can insert today’s date and time.



Figure 1.74 Screenshot of PLABWIN10: Showing the available commands in the
Edit menu.

Step 12
Type any sentence in the Notepad.

For this task, you can also use the following sentence:

This is just a sample text.





Figure 1.75 Screenshot of PLABWIN10: Entering text in the Notepad document.

Step 13
Copy the sentence and paste it four more times in continuation of the existing text.

This is just a sample text. This is just a sample text.


This is just a sample text. This is just a sample text.


This is just a sample text.



Notice a scroll bar appears at the bottom.



Figure 1.76 Screenshot of PLABWIN10: Copying and pasting the same text
multiple times.

Step 14
Click Format and select Word Wrap.



Figure 1.77 Screenshot of PLABWIN10: Selecting the Word Wrap option from
the Format menu.

Step 15
The text is now wrapped to the next line automatically, and the scroll bar has
disappeared.



Figure 1.78 Screenshot of PLABWIN10: Showing the wrapped text in the
Notepad document.

Step 16
Highlight the text. Click Format and then select Font.



Figure 1.79 Screenshot of PLABWIN10: Selecting the Font option from the
Format menu.

Step 17
The default font is set to Consolas, Regular, and 11.

Try changing it to the following:

Courier New, Bold, 14



Click OK. Remember that these changes are only applicable to the current document.



Figure 1.80 Screenshot of PLABWIN10: Changing the font, size, and font style
for the selected text.

Step 18
You can see that the font changes have been applied.



Figure 1.81 Screenshot of PLABWIN10: Showing the changed text with the new
font, size, and font style.

Step 19
Close Notepad. Do not save changes to the document.



Figure 1.82 Screenshot of PLABWIN10: Closing the Notepad window without
saving the text.

Step 20
You should have now returned to the desktop.



Figure 1.83 Screenshot of PLABWIN10: Showing the desktop of PLABWIN10.

Task 5 - Use File Explorer

Windows File Explorer gives easy access to all of your hard disk drives, the directories
inside the drives, sub-directories, and the individual files. Using this, you can also access
your application software(s), windows utilities, and various system settings.

It provides a view of the complete directory structure on one or more hard drives inside a
system. Using this organized structure, it is possible to easily navigate from one location
of your disk drive to another.

In file explorer, it is also possible to customize the way in which drives, folders, and files
are displayed. However, note that customization only impacts how the files and
directories are displayed on the screen. The actual files and directories are not impacted
by the customizations.

In this task, you will learn a few key functions of Windows File Explorer.



Step 1
Ensure that you are connected to PLABWIN10.

From the Windows taskbar, click File Explorer.

Figure 1.84 Screenshot of PLABWIN10: Clicking the File Explorer icon from the
Windows taskbar.

Step 2
The left pane displays libraries, folders, and volumes. When a folder, library, or volume is
selected in the left pane, the right pane displays its contents.

In the left pane, under This PC, select Local Disk (C:). Notice that the folders on the
selected volume are displayed. The File Explorer window displays tabs, address bar,
and search bar.



Figure 1.85 Screenshot of PLABWIN10: Displaying the File Explorer window
with Local Disk (C:) selected.

Step 3
Let’s try to search for a particular folder from the available list. Type following in the
search bar:

Windows



Press Enter. It displays the search results.



Figure 1.86 Screenshot of PLABWIN10: Searching for files and folders in File
Explorer.

Step 4
Notice that the address bar is showing a green progress bar. This indicates that more
results are being added to the right pane as the search continues.

Click x in the search textbox to close this search and its results.



Figure 1.87 Screenshot of PLABWIN10: Showing the search results and then
closing the search.

Step 5
You are back on the screen that displays Local Disk (C:) drive contents in the right
pane.



Figure 1.88 Screenshot of PLABWIN10: Displaying the File Explorer window
with Local Disk (C:) selected.

Step 6
Notice there are three arrows to the left of the address bar.

Left: Takes you to the previous screen.
Right: Takes you back to the screen you were on before clicking the left arrow. If
you click the right arrow, you will be taken to the search results.
Up: Will take you one level up in the directory structure. In this scenario, it will be
This PC.

Click the right arrow.



Figure 1.89 Screenshot of PLABWIN10: Clicking the right arrow in File
Explorer.

Step 7
Notice that you are shown the search results you previously accessed.



Figure 1.90 Screenshot of PLABWIN10: Showing the search result window.

Step 8
Click the left arrow.



Figure 1.91 Screenshot of PLABWIN10: Clicking the left arrow to visit the
previous screen.

Step 9
You are back on the screen that displays Local Disk (C:) drive contents in the right
pane.



Figure 1.92 Screenshot of PLABWIN10: Displaying the File Explorer window
with Local Disk (C:) selected.

Step 10
Let’s explore the tabs.

Click the Home tab.

This displays generic functions, such as copy, paste, cut, move to, copy to, and creation of
a new folder. You can also view the properties of a file or folder using the Properties
command.



Figure 1.93 Screenshot of PLABWIN10: Clicking the Home tab and displaying
its commands.

Step 11
Click the Share tab.

This tab displays the folder sharing options.



Figure 1.94 Screenshot of PLABWIN10: Clicking the Share tab and displaying
its commands.

Step 12
Select the Users folder in the right pane and click the Share tab once again to hide it.

Notice that with the selection of the Users folder, the Manage tab has disappeared. It is
important to note that some of the tabs are context-specific and are only visible if their
relevant object, such as a file, is selected.



Figure 1.95 Screenshot of PLABWIN10: Displaying the Users tab and showing
its commands.

Step 13
Click the View tab.

The current layout is set to Details by default. This tab contains the commands that
allow you to alter the visual settings of files and directories. For example, you can choose
to display file extensions, which are hidden by default. There are several system files that
are hidden. You can choose to display them by default by selecting the Hidden items
checkbox.



Figure 1.96 Screenshot of PLABWIN10: Showing various commands on the
View tab.

Step 14
On the View tab, click Options and then select Change folder and search.



Figure 1.97 Screenshot of PLABWIN10: Selecting the Change folder and search
option

Step 15
The Folder Options dialog box is displayed. There are three tabs:

Browse folders: Allows you to open folders in the same window or a new window.
By default, it is set to open folders in the same window.
Click items as follows: By default, you need to double-click to open a folder. You
can configure it to open with a single click.
Privacy: By default, recently used files are shown in Quick access, which also
displays the frequently used folders. You can choose to disable both the settings.



Figure 1.98 Screenshot of PLABWIN10: Showing the General tab of the Folder
Options dialog box.

Step 16
Click the View tab.

This displays the settings specific to files and folders.



Figure 1.99 Screenshot of PLABWIN10: Clicking the View tab and displaying
the various options to display files and folders.

Step 17
In the Advanced settings section, select Show hidden files, folders, and drives.

Also, deselect Hide extensions for known file types.

Click Apply.



Figure 1.100 Screenshot of PLABWIN10: Selecting the Show hidden files,
folders, and drives option and then deselecting Hide extensions for known file
types.

Step 18
Click the Search tab, which includes the search and index settings. Notice that the
Include system directories checkbox is already selected.

Select the following:

Include compressed files (ZIP, CAB…)
Always search file names and contents (this might take several minutes)

Click OK.



Figure 1.101 Screenshot of PLABWIN10: Clicking the Search tab and then
selecting the required checkboxes. OK is selected.

Step 19
You are back on the File Explorer window. Notice the ProgramData folder. This is
dimmed in comparison to the other folders as it is hidden.

Close the File Explorer window.

Note: If time permits, navigate to some of the system directories, such as
Windows. Verify if the file extensions are now being displayed.



Figure 1.102 Screenshot of PLABWIN10: Displaying the hidden folder named
ProgramData.

Step 20
You should have now returned to the desktop.



Figure 1.103 Screenshot of PLABWIN10: Showing the desktop of PLABWIN10.

Task 6 - Use MSinfo32

Msinfo32 gives you a comprehensive view of system-related information. This
information is primarily covering the hardware setup, software setup, and peripheral
devices.

Using Msinfo32, information about various aspects/features of the system, such as the
operating system (OS), random-access memory (RAM), sound devices, display devices,
network adapter(s), printers, USB devices, print jobs, and system services can be viewed.

In this task, you will explore MSinfo32.

Step 1
Ensure that you are connected to PLABWIN10.



In the Type here to search textbox in the taskbar, type the following command:

msinfo32



Under the Best Match section, select System Information.

Figure 1.104 Screenshot of PLABWIN10: Selecting System Information from
the search.

Step 2
By default, the System Summary is selected in the left pane, and its information is
displayed in the right pane.



Figure 1.105 Screenshot of PLABWIN10: Showing the System Summary
information in the right pane.

Step 3
For example, to view the display device-related information, select Display under
Components.



Figure 1.106 Screenshot of PLABWIN10: Showing the information after
selecting Display.

Step 4
Expand Software Environment and then select Services.



Figure 1.107 Screenshot of PLABWIN10: Expanding Software Environment to
select Services.

Step 5
Close the System Information window.



Figure 1.108 Screenshot of PLABWIN10: Closing the System Information
window.

Step 6
You should have now returned to the desktop.



Figure 1.109 Screenshot of PLABWIN10: Showing the desktop of PLABWIN10.

Task 7 - Use the Microsoft Management Console (MMC)

MMC stands for Microsoft Management Console. As the name suggests, it provides users
with a collection of tools useful for performing managerial activities. It is a combination
of the graphical user interface and programming framework. MMC is essentially a
container where all these managerial functions can be accessed in one place.

In this task, you will explore MMC.

Step 1
Ensure that you are connected to PLABWIN10.

In the Type here to search textbox in the taskbar and type the following command:



mmc.



Under the Best Match section, select MMC.

Figure 1.110 Screenshot of PLABWIN10: Selecting MMC from the search.

Step 2
On the Console 1 - [Console Root] window, select the File tab and select
Add/Remove Snap-in.



Figure 1.111 Screenshot of PLABWIN10: Selecting the Add/Remove Snap-in
option from the File menu.

Step 3
The Add or Remove Snap-ins dialog box is displayed. Snap-ins are useful for
administering the computer system, connected networks, system components, and
services. In the left pane, a list of available snap-ins is displayed, and on the right-hand
side are the added snap-ins.

Select the Authorization Manager from the left pane, and click Add.



Figure 1.112 Screenshot of PLABWIN10: Adding the Authorization Manager
snap-in to the Selected snap-ins list.

Step 4
Authorization Manager has now been added to the Select snap-ins section. Click OK.



Figure 1.113 Screenshot of PLABWIN10: Showing the Selected snap-ins list with
the Authorization Manager snap-in added.

Step 5
You are back on the Console1 window. Notice that the Authorization Manager snap-
in is now added.



Figure 1.114 Screenshot of PLABWIN10: Showing the Authorization Manager
snap-in added in the Console1 window.

Step 6
Let’s save the snap-in. Click File and select Save As.



Figure 1.115 Screenshot of PLABWIN10: Selecting the Save As option from the
File menu.

Step 7
The Save As dialog box is displayed. Click Desktop in the left pane.

In the File name text box, Console1.msc is the default name that is displayed. Type
the following name:

AuthorizationManager



Click Save.



Figure 1.116 Screenshot of PLABWIN10: Saving the snap-in with the new name
on the desktop.

Step 8
The title of the console has been successfully changed to AuthorizationManager.
Close the AuthorizationManager window.



Figure 1.117 Screenshot of PLABWIN10: Showing the changed titled as
AuthorizationManager.

Step 9
You are now back on the desktop, which contains the AuthorizationManager.msc
file. Double-click this file.



Figure 1.118 Screenshot of PLABWIN10: Showing the
AuthorizationManager.msc file on the desktop and double-clicking it to open it.

Step 10
The AuthorizationManager console window is now displayed.



Figure 1.119 Screenshot of PLABWIN10: Showing the AuthorizationManager
console window.

Step 11
Click File and select Add/Remove Snap-ins.



Figure 1.120 Screenshot of PLABWIN10: Selecting Add/Remove Snap-ins
option from the File menu.

Step 12
In the Add or Remove Snap-ins window, select Authorization Manager in the
Selected snap-ins list and click Remove.



Figure 1.121 Screenshot of PLABWIN10: Selecting Authorization Manager
snap-in in the Selected snap-ins list and then clicking Remove.

Step 13
The Authorization Manager snap-in is successfully removed from the Selected
snap-ins list. Click OK.



Figure 1.122 Screenshot of PLABWIN10: Showing the empty Selected snap-ins
list after removal of Authorization Manager snap-in.

Step 14
The AuthorizationManager console no longer contains the Authorization
Manager snap-in. Close the AuthorizationManager console.



Figure 1.123 Screenshot of PLABWIN10: Showing the AuthorizationManager
console after the Authorization Manager snap-in removal.

Step 15
The Microsoft Management Console dialog box is displayed. Click Yes to save the
settings.



Figure 1.124 Screenshot of PLABWIN10: Saving the AuthorizationManager
console by clicking Yes on the Microsoft Management Console dialog box.

Step 16
You are back on the desktop. Select the AuthorizationManager.msc file if not
already.



Figure 1.125 Screenshot of PLABWIN10: Selecting the
AuthorizationManager.msc file from the desktop.

Press Shift+Delete to delete it.

Note: When prompted for confirmation of the deletion, click Yes.

Step 17
The desktop no longer contains this file.



Figure 1.126 Screenshot of PLABWIN10: Showing the desktop of PLABWIN10.

Task 8 - Use Dxdiag

DxDiag is a diagnostic tool, primarily used for detecting errors on the system. It displays
information about various aspects of the system, including the DirectX components and
drives installed. DirectX components facilitate the smooth running of rich multimedia
content on Windows-based machines. To run rich multimedia content, a lot of system
resources are needed. DirectX components fulfill this resource need. This information fits
into four categories. These categories are System, Display, Sound, and Input. By
analyzing this information, a fault can be identified.

In this task, you will view some of the information provided by Dxdiag.

Step 1
Ensure that you are connected to PLABWIN10.



In the Type here to search textbox in the taskbar, type the following command:

dxdiag



Under the Best Match section, select dxdiag.

Figure 1.127 Screenshot of PLABWIN10: Selecting dxdiag from the search.

Step 2
The DirectX Diagnostic Tool window will appear.

Click Yes.



Figure 1.128 Screenshot of PLABWIN10: Clicking Yes on the DirectX Diagnostic
Tool dialog box.

Step 3
The System tab is displayed by default.

This tab displays the Windows and basic hardware information, such as CPU and
memory. It also displays information about the pagefile.



Figure 1.129 Screenshot of PLABWIN10: Showing the System tab.

Step 4
To view the display-related information, click the Display tab. Notice that most of the
information is marked as Unknown. This could be due to this system being a virtual
machine, and there is no real graphics card being used.



Figure 1.130 Screenshot of PLABWIN10: Showing the Display tab.

Step 5
Click the Sound tab. Notice that the information related to Sound is displayed.



Figure 1.131 Screenshot of PLABWIN10: Showing the Sound tab.

Step 6
Click the Input tab.

Notice that the DirectInput Devices section displays two devices, mouse and keyboard.

Click Exit.



Figure 1.132 Screenshot of PLABWIN10: Showing the Input tab.

Step 7
You should have now returned to the desktop.



Figure 1.133 Screenshot of PLABWIN10: Showing the desktop of PLABWIN10.

Task 9 - Use the Defragment and Optimize Drives Utility

The Defragment and Optimize Drives utility allows you to make your computer run more
efficiently. This utility scans the drive to decide if it needs to be optimized. Users have the
choice to decide which drives should be optimized or scanned. Drive optimization is the
process of increasing the efficiency of the drive. For that, the scan is performed across the
drive to find out how the is data stored and where are the vacant sectors. Internal and
external drives can be scanned. It is also possible to schedule optimization.

In this task, you will perform some of these functions.

Step 1
Ensure that you are connected to PLABWIN10.



In the Type here to search textbox in the taskbar, type the following:

Defragment and optimize drives



Under the Best Match section, select Defragment and Optimize Drives.

Figure 1.134 Screenshot of PLABWIN10: Selecting Defragment and Optimize
Drives from the search.

Step 2
In the Optimize Drives window, select (C:), then click Analyze.



Note: This may take a while to complete. It depends on the amount of data and the
size of the hard drive.

Figure 1.135 Screenshot of PLABWIN10: Clicking the Analyze button.

Step 3
Click the Change settings button.

Options in the appearing window will allow you to schedule when the optimization of
drives shall take place.



Figure 1.136 Screenshot of PLABWIN10: Clicking the Change settings button.

Step 4
The Optimize Drives dialog box is displayed.

Click the Frequency drop-down list and select the Daily option. This will make sure
optimization is completed daily.

Click OK.



Figure 1.137 Screenshot of PLABWIN10: Setting Frequency to Daily in the
Optimize Drives dialog box.

Step 5
Click Optimize. Notice that the Current Status says that the drive Needs
optimization.

In the Scheduled Optimization section, it mentions that Drives are being
optimized automatically.



Figure 1.138 Screenshot of PLABWIN10: Clicking the Optimize button to start
optimization.

Step 6
Click Close.



Figure 1.139 Screenshot of PLABWIN10: Clicking Close on the Optimize Drives
dialog box.

Step 7
You should have now returned to the desktop.



Figure 1.140 Screenshot of PLABWIN10: Showing the desktop of PLABWIN10.

Task 10 - Use Windows Update

Windows updates allow you to get the latest available version of windows for your
operating system. As soon as the updates are released from the manufacturer, they are
shown in this part of the system for you to apply. There are two different methods that
can be used to apply updates:

Manual: You must have an internet connection in order to complete the updates.
You need to trigger the download of updates manually.
Automatic: You must configure the system to download the updates. However, the
system can be configured to download updates as they are available. This type of
configuration is good for a single system at home. The automatic method can also
use an internal update server to push the updates to the systems on the network.
Using an internal update server is more suitable on a network. This helps in
avoiding network congestion that can occur if hundreds of systems are downloading



the updates at the same time. The internal update server connects to the Internet,
downloads the updates, and distributes them on the internal network.

In this task, you will learn to use Windows Update.

Step 1
Ensure that you are connected to PLABWIN10.

In the Type here to search textbox in the taskbar and type the following command:

windows updates settings



Under the Best Match section, select Windows Update settings.



Figure 1.141 Screenshot of PLABWIN10: Selecting Windows Update Settings
from the search.

Step 2
Click the Change active hours link.

Figure 1.142 Screenshot of PLABWIN10: Clicking the Change active hours link.

Step 3
The Active Hours dialog box is displayed. The default timings are:

Start time: 8:00 AM
End time: 5:00 PM

Change the start and end time to 9:00 AM and 6:00 PM.



Click Save.

Figure 1.143 Screenshot of PLABWIN10: Changing the work timing in the
Active hours.

Step 4
Click the View update history link.



Figure 1.144 Screenshot of PLABWIN10: Clicking the View Update history link.

Step 5
The View update history page is displayed.

Click the Uninstall updates link.



Figure 1.145 Screenshot of PLABWIN10: Clicking the Uninstall updates link.

Step 6
The Installed Updates dialog box is displayed.

To uninstall an update, you would select the update that you want to uninstall and click
Uninstall.

For this task, you should not uninstall an update. Close the Installed Updates dialog
box.



Figure 1.146 Screenshot of PLABWIN10: Selecting an update and clicking
Uninstall in the Installed Updates.

Step 7
You are back on the View update history page. Click the back arrow.



Figure 1.147 Screenshot of PLABWIN10: Clicking the back arrow on the View
update history page.

Step 8
You are back on the Windows Update page.

Click the Advanced options link.



Figure 1.148 Screenshot of PLABWIN10: Clicking the Advanced options link on
the Windows Update page.

Step 9
You are now on the Advanced options page.

Click Off for Automatically download updates, even over metered data
connections (charges may apply).



Figure 1.149 Screenshot of PLABWIN10: Clicking the automatic update options
on the Advanced options page.

Click the back arrow.

Step 10
Notice that Check for updates button is no longer visible. While you were configuring
settings, Windows is performing a check for updates.

Note: You may not get the same result for this step. If your session shows the
Check for updates button, you should click and perform an update.



Figure 1.150 Screenshot of PLABWIN10: Showing the Check for updates on the
Windows update page.

Review

Well done, you have completed the Get to Know Various System Utilities Practice
Lab.

Summary

In this module, you will complete the following exercise:

Exercise 1 - Get to know Various System Utilities

After completing this lab, you will be able to:



Explore Registry Editor
Use the Services Console
Use the Microsoft Terminal Services Client (MSTSC)
Use Notepad
Use File Explorer
Use MSinfo32
Use the Microsoft Management Console (MMC)
Use Dxdiag
Use the Defragment and Optimize Drives Utility
Use Windows Update

Feedback

Shutdown all virtual machines used in this lab. Alternatively, you can log out of the
lab platform.


